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1  KMS Datalog

Kronenburg Management Systems (KMS) is a complete line of programmable engine control units
(ECU), that offers you an extremely reliable and user-friendly system at a very competitive price. It
gives you the possibility to manage all turbo and naturally aspirated Otto engines (engines in which
the fuel mix is ignited via a spark plug) up to 12 cylinders.

An engine control unit is a type of electronic control unit that determines the amount of fuel,
ignition timing and their parameters which are needed to keep an internal combustion engine
running. It does this by reading values from multidimensional maps which contain values calculated
by sensor devices monitoring the engine.

The programmable KMS ECU doesn’t not have a fixed behaviour, but can be (re)programmed by the
user. Programmable ECU’s are required when a significant modification has been made to a vehicle's
engine. For example adding a turbocharger, changing the camshaft profile or a conversion to an
alternative fuel. In these situations, a programmable KMS ECU can be wired in. The KMS ECU’s can
be programmed/mapped with a computer connected using a serial or USB cable, while the engine is
running.

The programmable ECU controls the amount of fuel to be injected and the ignition moment for each
cylinder. This varies depending on the engine's RPM and the position of the throttle valve and/or the
Manifold Absolute Pressure (MAP). This can be adjusted by bringing up a spreadsheet page on the
screen where each cell represents an intersection between a specific RPM value and a throttle
position. In this cell a value corresponding to the amount of fuel injected can be entered. This
spreadsheet is referred to as a fuel table or fuel map. The same way the ignition spreadsheet can
be setup.

By modifying these values while monitoring the exhaust gas composition (best way is using a wide
band lambda sensor) you can see if the engine runs rich or lean. This way you can find the optimal
amount of fuel and optimal ignition moment needed for all possible combinations of RPM and
throttle position/manifold absolute pressure. This process can be best carried out at a
dynamometer, giving a controlled environment (without influence from outside) to work in. An
engine or chassis dynamometer gives a more precise calibration for your (racing) applications.

The KMS MD35 ECU offers a complete self learning air fuel ratio control (lambda control) for most
common types of oxygen sensors (broadband/narrow band).
In addition to lambda control, this management system also provides the following functions: load-
dependent boost pressure control, water injection control, (variable) launch control, power-
shifting, (variable) A.L.S., staged/banked injection, mapselector, odd fire, idle control, rpm
limiters, engine diagnostics, 4mb datalogging, etc. The internal datalogging is what this manual is
about.

Kronenburg Management Systems has developed an internal datalogger in the MD35 engine
management system.

This datalogger contains 4 MB of storage. It can read 58 channels (34 analog and 24 digital) of
information and is fully adjustable to the personal requirements.

KMS Datalog manual
KMS Version 1.4.0.2 3




2 Software installation

The software is supplied together with the system, on a CD-ROM. Installing the software is very
easy. The CD-ROM carries the KMS installation program, which launches automatically when the CD
is inserted.

[ ®... KMS install menu Version 1.03

L

PR\

— KMS
uKn_Jnenburg‘_

——
— Nede %Moﬁomanagememv@nlomt KM s
Tt

e ¥ Datalog version Kranenburg i\
anagement Systems
% e -«=» www.van-kronenburg.nl

% Ignition version

@ KMS Firmware downloader

‘7‘5_! o« Qg;ggﬁ Adobe Reader 4.0

Close.

If you click on the button ‘datalog version’ the installation of the datalog software will start.

15 Setup - KMS Datalog n my:- =) {5 Setup - KMS Datalog n m@]&@

Select Destination Location
KMS b Welcome to the KMS Datalog Wihere should KNS Datalog be installed?
Kronenburg S Setup Wizard
Management System

o wewwvan-krenenisurg.nl

This wil install KMS Datalog 1.3.0.2 on your computer.
| Setunwilinsiall KMS Datdlog into the follwing folder

his d that you close ll other before
continuing To continue, click Neat. Fyou wouid like to select a different folder, click Browse
| Click Next lo cortinue, or Cancel to exit Setup. |  Proaram Fles KIS \KMS Daialog Browss

Atleast 2,1 MB of free disk space is required.

' Next > i <Back || Net> | [ Cancal

The installation software will ask were the software must be installed.
We recommend to install the software in the same place as the rest of the KMS software to keep
things organised.

18) Setup - KMS Datalog n m@i‘@ 15 Setup - KMS Datalog n m@%

Select Additional Tasks .
Which addtional tasks should be peformed? P rﬁﬂg v gg{:gﬁl{;g rtcll]e KMS Datalog
Management System

ot wewwvan-krarenisurg, l

Setup has finished instaling KMS Datalog on your computer.
The application may be launched by selecting the installed
icons

Select the additional tasks you would like Setup to perfom while instaling KMS Datalog,
then click Next

Addtional icons )
e | Click Finish to exit Setup.
Creale 3 desidop icon, !

[7] Create a Quick Launch icon {aunch KM Datalog

' ] [ |

After the installation there is the option to choose if you want shortcuts and where you want them.
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Finally the confirmation and the question if you want to start the software directly. This is not
necessary, so if you don’t want to start the software that instant just deselect this option.
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3  KMS datalog software

3.1 Start-up

When the software is started up, the screen below will appear and after the KMS logo disappears
the datalog software is ready to use.

TG M P e BN L1204 5m

KMS ,

W\
Kronenburg -\
anagement System

«+=» www.van-kronenburg.nl

Close Version [1.4.0.1

The program doesn’t automatically load the data from the ECU like the KMS Management software.
You can load a saved file on the computer or make a connection with your ECU to receive the stored
data.

3.2 Setting up the ECU

It’s very important that the settings are set correct in the ECU. This determines what kind of data
you get after downloading the data out of the ECU.

3.2.1 Communication port

First step is selecting the right communication port.

File Edit View Unit [Tools] Help
D | Search CTRLE |2 3 4 5 in

Channel Report CTRL+R }

Preferences 3 Communication I

Settings v Graphs

2% Graph Dialog 1 -

Leg Information CTRL+L

Communication Preferences ==
OK

Wihich COM port would you like to use?
IR -
Cancel
The USB device is installed as a COM port.

To which COM port s the MD35 connected? |

Number of attempts in case of communication errors?
10 —

Waiting time between two attempts {in ms)?
10

=% Graph Dialog 2 - Zoom level (visible): 100%
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At the tab communication preferences, the COM port can be selected. If you don’t know the COM
port number where the USB cable of the MD35 ECU is at, click the button and the software will

search for the correct COM port. You do have to fill in the COM port manually at the pull down
menu.

3.2.2 Retrieve unit information |»&

When the COM settings are correct we can now ‘read’ the ECU.

File Edit View [Unit] Tools Help

DS HE Retrieve Unit Information CTRL-1 4 5
Retrieve Channel CTRL+H
S Graph Dial Upload Data CTRL+U
Clear Memory CTRL+M
Unit Information ===
e

vesn [FRBGTE
swaivo. [
Defaltconfigno. [MO02
No.andlogchennels  [3+ I
No.dgtalcharnels  [24
System time actvated | Yes f—
Viimal tmestep [5
No.memoryblods [T | =
No.pagesperblock [8192
No.bytesperpage [58

= Graph Dialog 2 - Zoom level [visible): 100%

Go to ‘Unit’ = ‘retrieve unit information’ and the information about the ECU that is connected will
be displayed.

3.2.3 Setting up the channels |»=

When the MD35 ECU comes out the box, certain standard settings i e ves [ oo rep
for the datalog are made. D&H Retrese Uritnfo

Retriew

nel ion
=4 Graph Dial Upload Data CTRL+U

The ECU will store data even if there aren’t any changes made. =ty e

Standard the ‘trigger’ channel (which starts the data storage) is
set to channel 0.

So when the engine rpm becomes more then 1000 RPM the
datalog starts saving the vehicles’ data. This is when the ECU
Seifomeien == isn’t touched.

CTRL+1 4 5 I
CTRL+H

The trigger can be set
to any channel with an own specified start value.

Just select the channel which you want to adjust and press
the edit button.

The ‘edit .... channel’ screen will appear.

As an example we opened channel 0 (an analog channel)
to demonstrate how the channel can be changed.

In the picture on the right, you can see the definition of
the RPM channel.

v A different name can be given to this channel and the
unity.
At the Formula data are some numbers filled in. To display
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the data in a certain way on the screen these numbers can be adjusted.

Example : if the number 100 is entered at X2 then you get the same value displayed as the
dashboard RPM gauge in the vehicle.(so 300 RPMx10 changes in 3 RPMx1000)

After the settings for the selected channel have been made, just click the close button. If all the
channels are adjusted to the personal requirements push the download button. The new made
datalog settings will be send to the ECU.

KMS Datalog =5

This message can appear if the ECU is not connected to the battery % Eror TIMEOUT. N

. . . . %4 Please ensure that the unit is connected.
and supplied with 12V, or the communication between the computer h
and ECU isn’t there anymore.

You can save the settings you have made to the different channels and save them on the computer.
The extension for this file is *.kms.

After these adjustments the datalog in the ECU is set to your personal settings and is ready to use.

3.3 Uploading the data

To actually start working with the data which is stored in the ECU, the information must be
transferred from the ECU to the computer.

Make sure that the ECU is supplied with 12V and that the USB cable is connected to the computer.

File Edit View [Unit] Tools Help

3.3.1 Uploading run(s) e e iy CaE
When selecting ‘Upload Data’ the following =
screen (on the right) will appear. e — (o= |
l;;‘rggnn(sez) | Upload Run(s)
Example : At this example, we have 7 runs —
which we can upload from the ECU to the
computer.
All runs can be uploaded together, but | [=cwivims oo womo oo
separate too. There is also the option to
upload just a part of a specific run.
3.3.2 Uploading part of the run R e
Which part of the run do you want to upload?
At the ‘Upload part’ screen, there can be seen how long the Run rumber |6 bossble P—
specific run is. sarcsme@[0 ([0
You can insert your own period of time (between the lower en
upper limit) which you want to upload to the computer. = sl reE
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3.3.3 Report after uploading run

After completing the upload process the
datalog software will first show you a report
of the ‘run’.

The maximum, minimum and average values
will be shown for every channel you
activated.

This channel report can be called back later
by clicking ‘Tools’=>’Channel report’.

3.3.4 Displaying data

The Datalog software main screen is divided in 4 sections.
There is the ‘channels’ screen, where all the activated channels

screen are the 3 ‘graph dialog’ screens.

Channel Report

Channel

Min

Max

= el .

RPM

Injection
Ignition

Engine Load TPS
Coolant Temp.
Air Temp.
Battery Volts
Lambda Sensar 1
Analog ALX2
Analog AUX3
Correction Fuel
Boost PWM
Thath Cannt

0.00
0.00
0.00
7.80
17.00
33.00
12.00
9.50
0.00
0.00

0.00
nnn

3750.00

32.10
7.80
36.00
40.00
12,25
9.50
0.00
0.00
33.70
0.00
&N nn

3738.36

31.55
7.80
20,62
39.03
12.00
9.50
0.00
0.00
-33.86

m

5q as

are seen. Next to the ‘channels’

Ele fda View Unt Tock Help

D@ & ¢ =aeienx 5% § 123465

ph Diskog 1 - Zoom heved (visiblek: 100%

Graph Dialog 1

Graph Dialog 2

5 Graph Dislog 3 - Zoom level [visiblel: 100%

Graph Dialog 3

oepmar [

The graph dialog(s) can be switched on/off by selecting the concerning graph dialog in the menu
‘View’>’Graphs’ = ’Graph Dialog 1/2/3. The channel screen can also be switched on/off by

selecting ‘Channel List’ in the ‘View’ menu.
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Channels from the ‘channels’ screen can be dragged with 52 ]
the mouse to the ‘graph dialog’ screen. You can select :

B | Channels

22

multiple channels at once before dragging them to a
graph dialog. Hold ‘Ctrl’ and select multiple channels.
There is a maximum of 4 channels which you can drag to
one specific ‘graph dialog’ screen.

Channels don’t necessarily need to be dragged to the
graph dialog. You can also click the right-mouse-button
and then select on which graph dialog the channel has to
be displayed.

| Channel name

| Value

Ignition

Engine Load TPS
Coolant Temp.
Air Temp.
Battery Volts
Lambda Sensor 1
Analog AUX2Z

Analog ALIY3

3.4 Interpreting the data

Add to Graph Dialog 1
Add to Graph Dialog 2
Add to Graph Dialog 3

RPM
Injection

There are some manners for easier understanding the data shown in the graph dialog(s). These

options in datalog software will be explained in the following sections.

3.4.1 Zoom

If you press the left mouse button (keep pressed) and drag the mouse to the right, the graph will
zoom in. If you drag the mouse the other way with the left mouse button pressed, the graph will

zoom out.

In the blue bar you can see the zoom level (how much the graphs are zoomed in).

=% Graph Dialog 1 - Zoom level (visible); 100%

[y
3340.00
1350
-4.30 Zq{ju.‘un\(

25.70 4

0.80 H
192.52\?

2510.00 5

101000 T T T T T

T
0:00 (m:s) 0:20 0:40 1:00
RPM [Rev/Min] Lambda Sensor 1 (AinfFuel)  Correction Fuel (%) Engine Load TPS [LoadSite]

Another option on the zoom is, that when the space-bar is hold, then the marked area is showed in

time. So you can see in what time period you are zooming.

= Graph Dialog 1 - Zoom level (visible): 100%

Eloks

7
1060.00

25.70 | 111410

=6.00
= 3.00

-4.30 :q_s.ﬁn \[

=e2100 — 000

E 16.00

E11.00

2510.00 4

1010.00 T T T T T

T T
0:00 m:s) 0:20 0:40 1:00 : E 2:00
RPM (Rev/Min) Lambda Sensor 1 [AirfFuel]  Correction Fuel (%)  Engine Load TPS [LoadSite]

With a graph zoomed in you can scroll through time using the ‘Ctrl’ button simultaneously while

pressing the arrow key left of right.
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KMS

3.4.2 Legend

When moving the cursor over the lines in the graph dialog(s) the y-axis value of these channels will
be displayed in the legend. These values are also displayed in the channel screen. The position of
the legend in the graph dialog can be changed. Go to ‘View’ > ‘Legend’. In this menu there is also
the option of switching the legend off by pressing ‘Toggle Legend’. When ‘Toggle Unity’ is selected
in this menu, the unity of the channels will be shown behind the values in the legends.

File Edit Unit  Tools Help
DESRY

Toolbar x|= % i1 2345

¥ StatusBar
2% Grg ible): 100% [=la] = ]
Graphs » —
L d » Toggle Le d =600
egen oggle Legen =
2 B =300
v Channel List Toggle Unity =
2100 — 000
Top Left E
oo bt Wg 16.00
op Ri £
: i QR = E11.00
=i 0:3.290
2.20
4 12.10
2510.00 5 12.80
3 1970.00
1010.00 T T Tl 1 T T T T T T T T T T T T T T T T T T T I T L T T
0:00 fm:s) 0:20 0:40 1:00 1:20 1:40 200 2:20 2:40
RPM (RevjMin] Lambda Sensor 1 (dirfFuel]  Correction Fuel (%)  Engine Load TPS (LoadsSite]
o, r 3
Search Tool ﬁ

3.4.3 Search

Choose channel and values to search for: oK |

Value of | Correction Fuel

If you select ‘Tools’ = ‘Search’ in the menu, a search
screen will appear. In this screen you can select the
channel you want to search. For example when the
‘Correction Fuel’ channel exceeds 15%. Every time the
correction fuel exceeds 15% will be displayed (see

has to be | greater than -
15

Show resultin | Graph 1 -

One search per channel {in a graph dialog) is allowed.

=

Cancel

picture below). Double click an item to view this part. -
A blocked yellow line is visible in the graph dialog representing the 15%.

D @@ & ¢ wseacsx 85 a i1 2346

rec (/T VY N = e Hyn-n = [

- VAT (e tte =1 el v

[ Vo W U Ul fot e ! | = 0.0n
3.4.4 Export to Microsoft Excel
Edit View Unit Tools Help

The KMS Datalog file can be opened with Microsoft 2:"“ gl FEcRe IR E| | BN
Excel. In Excel you can add your own formulas for . Coles | wisible 100%
calculations or make your own graphs. To export the Save As..
datalog file as a *.CSV (comma separated values) to Eeot O
Microsoft Excel go to ‘File’ - ‘Export to CSV’. Rename T
the file and select the folder where you want to save R—
the CSV. bt
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3.5 Help - Shortcuts

There are shortcuts and easy buttons for almost every option that will be mentioned in this manual.
The easy buttons are shown in the picture below.

o
6'\\0
O o
O &
S P
ot <
\S\%'\(‘\\ (\(\ C\ O<\ @C“\
CREOLL L O PN
@ (\06 N o & S "
KNI S @ @ & 0 O
A A obéooé\c}oo“@ & &
F o AT SN SIS @ 2
Lo SFEFeeRe ooy ° .
D2 E B " ® w2wEeg x = % i1 2 3 4 5 [

‘Help-Shortcuts’ in the ‘Help’ menu will provide some quick adjustment buttons in active channel
windows.

Help - Shortcuts 3 4 5 I
About KMS Dataleg
VETATElET o0y 5
s Help - Shortcuts @
f
130'["] Shortcuts:
5.70 ]_/_/
.20 Retrieve Unit Information CTRLH
RO Retrieve Channel Information  CTRL+H
20.250 Upload Data CTRL+U
vy Clear Memary CTRL-+M
Search CTRL4E
Channel Report CTRL+R
In an active channel window:
Select graph 1..4 Press 1..4
Zoom to original Press 7
Deselect Press X
Remove selected graph Press DEL
[m:s) Scrollin time CTRL+ <-or ->
Toggle legend 1]
w Toggle legend unity 5
Legend top left 5
Legend top right 7
—_ | Legend bottom right 8
wel [visible): 100] | Legend bottomleft 9
- i 4
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3.6 Personal settings

The datalog software is adjustable to your own preferences.

File Edit View Unit Help

== Search CTRL+E lz 3 4 5 I
3.6.1 Colour adjustment S| e

Settings 3

You can adjust the colours of the channel displayed ol L”“"”"”M
in the graph dialogs. To change the colours go to o= L\JU

‘Tools’ > ‘Preferences’ - ‘Graphs’

You can also change the background colour and the Jv M
scale colour of the graph dialogs. f:ggg;
Just drag the bars up and down and you will see the Y P 0:40 1200
colours Changing RPM [ReviMin] Engine Load TPS [LoadSite] Lambda Sensor 1 [AirfFuel]  Correction Fuel [
[ Graph Preferences Iél‘
Change the graph colors

Graph 1 Graph 2 Graph 3 Graph 4 Background Axis Search
g e e T —

[TTTTTLAT AL

R G

3.6.2 Graph dialog settings |

File Edit View Unit Help

There are some settings build in the program, to |p =g ™ Tomm: o: |2 3 4 & o
make understanding the data much easier. (| ChannelReport  CTRL:R

You can adjust the scale and positions of the graph i Graph Dislog 1-) ,

inside the dialog screen. Settings ’

There is also an option to auto-open the graphs in Loairformation  CTRLAL

the preferable dialog. ’

3.6.2.1 Scale

There are 4 different kind of scales which can be adjusted.

If you double click on the scale behind the sens: s
channel you will see the ‘edit setting’ ||res oo sou setine: Setthgs — — -
screen like on the right. | e Ao .

1

In this screen you can give the channel a | . |Ziom S I e
: caie :
-

preferable scale. You can select 1 of the 4 CH Eit":‘: o
oy v -
L]

scales which you have preset yourself. Or S Lemods Semor 1 o

just select ‘auto’ to let the software make [ ] |Adeamac auta L
a scaling between the maximum and =

minimum value of the channel. Edit setting

This works threw in all the 5 settings!

Please select your settings

OK
Scale | Auto j Cancel

KMS Datalog manual
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3.6.2.2 Auto open

The function auto-open gives you the

Auto
ability to adjust the software to your own e
needs. Graph Dialog 1 Graph Dialog 2 Graph Dialog 3
When you start the program the next 1. |None =] . |[vore =] . Jnone =)
time after you have set the ‘auto open’ 2. |NONE -] ..J|N0NE x| . |[none ~| .
opti.<t).ns, tptih amour;]t o'fll ghraphs and 5. [NonE e o ||—_|
positions of the graphs will show as you = = b o
W]Sh. 4, | MONE petin I .:I‘JE [l s ,NE

The three columns stand for the three

different graph dialogs in the main screen. There’s a maximum of four channels pro dialog, so
there’s a maximum of 12 channels you can show at once.

These ‘auto-open’ options can be made for are the 5 settings separately.

So you can set 5 different ‘auto open’ screens.

If you have selected the right channel on the right place of the graph dialog, then (if its desirable)

the height and offset of the channel in the graph dialog can be changed. Just click the dotted
button behind the pull down channel select menu.

Drag the bars like showed in the figures below and then the blue marked section will show you were
the channel in the graph dialog will appear.

r v
Graph Height and Offset &J Graph Height and Offset IéJ

Offset Height

. = Offset Height
Cancel m
1
EN e l_l_
L b

3.6.2.3 Engine information E

In this screen, information about the file and/or engine can be stored. So when the file is saved and
loaded again, you can always see of what date and engine it was.
This screen will only work If a datalog file is uploaded from the ECU or loaded from the computer.

File Edit View Unit [Tools| Help
= =] 1 Search CTRI+E |2 3 4 5 i
Channel Report CTRL+R

=% Graph Dialog 1 -
—_— Preferences 4

Settings 3

Log Information CTRL+L

Information | = ‘

Date oK
Vehicle Cancel
Engine

Comments
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4  Fault tracing

Possible causes Solution
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5 Specifications

Minimum system requirements

Windows 2000,NT,ME,XP or Vista (XP recommended)
Internal memory 64Mb (128Mb recommended)
Screen resolution 1280x1024

Standard USB port (USB 2.0 recommended)

CD-ROM station
Acrobat reader 3.0 or higher (Acrobat reader 5.0 is included on the CD-ROM supplied)
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